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1. Введение

В 2004-2005 учебном году моя работа «электронный учебник по теме: «Магнитное поле»» получил достойную оценку на городской конференции исследовательских работ учащихся. В этой работе я теоретически изучил тему «Магнитное поле», самостоятельно провел опыты по действиям магнитного поля, составил тест и продемонстрировал свой учебник своим одноклассникам. Такой вариант учебника им очень понравился. Они признали его  интересным, увлекательным и полезным.

Такая оценка моей работы со стороны жюри и со стороны моих одноклассников убедила меня в ценности этой работы, и я запланировал создать еще одно электронное пособие. Это электронный задачник по теме «Магнитное поле». Тему я решил не менять, т.к. задачник является логическим продолжением электронного учебника. 


Овладеть школьным курсом физики – это значит не только понять физические явления и закономерности, но и научиться применять их на практике. Умение решать задачи делает знания действенными, практически применимыми. 
Поэтому, целью моей работы является создание задачника, в котором собраны интересные, важные и практически применяемые вопросы. 
Для достижения этой цели я поставил перед собой следующие задачи: 
1. Изучить компьютерные программы для создания тестов, кроссвордов и задач.

2. Подобрать интересные вопросы для формулировки задач.

3. Представить задачи в нестандартных формах (видео сюжет, тест, кроссворд), для мотивации учеников к моему задачнику.
При создании задачника я использовал компьютерные программы: Microsoft Office Word, Microsoft Office Excel, Macromedia Flash MX 6, язык программирования HTML, Microsoft Office Power Point.

Предполагаемый результат моей работы: 

1. Использование электронного комплекта учебник-задачник на уроках физики, как учителем, так и учениками при самостоятельном изучении темы.

2. Развитие заинтересованного отношения учащихся  к предмету физики.
3. Заинтересованность учащихся в использовании языка программирования HTML и других компьютерных программ для самостоятельного создания различных видов источников информации.

2.Основная часть

Всякое применение общих положений физики для разрешения конкретного, частного вопроса есть решение физической задачи. Умение решать задачи делает знание действенными, практически применимыми.


Приступая к решению задачи, нужно, прежде всего, вникнуть в смысл задачи и установить, какие физические явления и закономерности лежат в ее основе. Затем выбрать оптимальный путь решения.
2.1. Описание задач в электронном задачнике.

В данном задачнике предлагаются четыре вида задач: тесты, кроссворд, текстовая задача и вопросы по видеосюжету.


В тестах следует внимательно читать вопрос и выбрать нужный ответ (ответ не обязательно один). По окончанию теста компьютер выдает оценку которую вы получили.


В кроссворде следует вставить ответы на вопросы по горизонтали, если все слова вами отгаданы правильно, то в выделенных клетках по вертикали получится слово, обозначающее катушку проводов с железным сердечником внутри. По окончанию работы выводится оценка:
оценка 5  от 78 до 87 баллов
оценка 4  от 65 до 78 баллов

оценка 3  от 43 до 65 баллов
оценка 2  меньше 43 баллов.


Текстовые задачи предполагают устное решение или решение с помощью черновика. Чтобы проверить свой ответ нужно щелкнуть по слову 
  и рассмотреть  предлагаемое решение. 


В задачах с видеосюжетом ответ на поставленный вопрос можно найти с помощью просмотра видеосюжета.

2.2. Описание компьютерных программ, используемых в электронном задачнике.

         Для того чтобы выполнить непростые, поставленные мною задачи, я использовал следующие программы:

Microsoft Office Word – это программа, предназначенная для работы с текстами. Программы такого рода часто называют текстовыми редакторами или текстовыми процессорами. При помощи Word можно создать, отредактировать и напечатать текстовый документ.

[image: image8.png]Boeave sonpoc

1 Hazm | SN WCTP BAN 3AM pycoc (Po |t | |





Microsoft Office Exсel – это программа, предназначенная для проведения расчетов, анализа и хранения данных. Иногда Excel называют электронной таблицей – и это правильно. Exсel является лидером среди программ этого типа.
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Программа Microsoft Office PowerPoint – позволяет создавать электронные презентации (слайд-шоу), способные оживить даже самую апатичную аудиторию. Каждая презентация Microsoft Office PowerPoint состоит из набора слайдов: текста и объектов, отображаемых на графическом фоне.

2.2.3.Программирование на языке HTML
Документы, хранящиеся на WWW, подготавливаются на специальном языке HTML. В HTML текст кодируется в ASCII и поэтому может быть создан    и отредактирован в любом текстовом редакторе. Кроме самого текста в документах имеются флаги разметки, которые интерпретируют клиентской программой просмотра (браузером) и позволяют воспринимать документ именно как гипертекст.

Любой гипертекст похож на книгу и может быть разбит на отдельные структурные элементы:

собственно текст;

главы, параграфы, пункты, подпункты;

абзацы.

Для каждого из этих элементов в HTML существует определенные стили, описывающие, в каком виде пользователь увидит текст на экране. Пусть мы создали файл minihtml.html:
<BODY>

<TITLE>Пример HTML – текста</TITLE>

<H1>Глава 1</H1>

<H2>Параграф 1.</H2>

Добро пожаловать в HTML!

Это пример гипертекста.<P>

<H2>Параграф 2.</H2><P>

<A HREF= “minihtml.html”>Пример HTML – текста</A> 

</BODY>

Из данного примера видно, что:

заголовок документа начинается с <TITLE> и заканчивается </TITLE>;

заголовок первого уровня (главы)выделяется символами <H1> и </H1>;

заголовок последующих уровней (параграфы, пункты, подпункты и т.  п. – символами <Hx> и </Hx>, где x – числа 2, 3, …

абзац – символами <P>.

Не все стили поддерживаются всеми WWW – броузерами. Если программа просмотра не поддерживает стиль, то она его игнорирует.

Основной текст отделяется от сопроводительного символами

<BODY>  </BODY>

Каждый HTML – документ должен иметь заголовок, который показывается отдельно и используется, прежде всего, для индетификации документа (нап- ример, при поиске). Заголовок должен описывать цель документа и содер – жать не больше 5 – 6 слов. Практически во всех броузерах заголовок доку -   мента виден в верхней части экрана (окна).

Для выделения заголовка служат символы

 <HEAD> <TITLE>Заголовок</TITLE> </HEAD>

HTML имеет шесть уровней заголовков, имеющих номера с 1по 6 (заголо – вок первого уровня является заголовком высшего уровня). По сравнению с  

нормальным текстом, заголовки выделяются шрифтом – размером и толщи- ной букв.Первый заголовок в каждом документе должен быть выделен <Н1>.      

Синтаксис заголовков:

 <Hy> Текст заголовка </Hy>

где y – число от 1 до 6, определяющее уровень заголовка.

В отличие от документов, в большинстве текстовых процессоров прерыва – ния строк и слов в HTML – файлах несущественны. Обрыв слова или строки может происходить в любом месте в исходном файле, при просмотре это пре- рывание будет проигнорировано. Напомню, что в моем примере, первый па- раграф был представлен как 

<H2>Параграф 1.</H2>

Добро пожаловать в HTML!

Это пример гипертекстов.<P>
В исходном файле два предложения находятся на двух разных строках. Прог- рамма просмотра игнорирует это прерывание строки и начинает новый абзац только, после знака <P>.

Главное преимущество HTML состоит в его способности связываться с дру – гими документами.Броузер выделяет (обычно цветом и/или подчеркиванием) ключивые слова, являющиеся гипертекстовыми ссылками (гиперссылками). Описывается ссылка на другой документ следующим образом:

<A HREF = “имя файла”>

Текст, который будет служить как обращение к другому документу </A>. Приведу пример такой гипертекстовой ссылки:

<A HREF = “minihtml.html”>Пример HTML – текста </A>
Здесь ключивые слова «Пример HTML – текста» являются гиперссылкой на файл minihtml.html, который находится в той же директории, что и текущий документ. Также можно ссылаться на документ в любой директории, описав к нему полный путь. Например, ссылку на файл NJStats.html, лежащий в под- директории AtlanticStates, можно описать так:

<A HREF = “AtlanticStates/NJStates.html”>New Jersey</A>

Это – так называемые относительные ссылки. Можно также использовать аб- солютное имя файла (полный путь). В общем случае, использование ссылки по абсолютному имени файла более предпочтительно.

Ссылки на документ, хранящиеся на других серверах, записываются с указа – нием их URL:

<A Href = http://www.simtel.ru/news/snews.http>News</A>

Гиперссылки могут также использоваться для соединения с определенными разделами документов. Предположим, необходимо соединить документ А с первой главой документа В. Для этого надо создать именованную гиперссыл- ку в документе В:

Здесь вы можите увидеть <A NAME = “Глава 1”>Главу 1</A> текст первой главы.

Теперь, описывая ссылку в документе А, надо включить не только имя файла documentB.html, но также и имя гиперссылки, отделяемое символом (#):

Здесь вы можете увидеть текст

<A HREF = “documentB.html#Глава 1”> Главы 1 </A> документ В

Теперь «кликнув» в слово «Главы 1» в документе А, можно перейти непос – редственно в Главу 1 в документе В.

Техника соединения с разделами текущего документа аналогична описанной выше, только опускается имя файла. Вот, например, связь с Главой 1 внутри того же самого файла (Документ В):

Это <A HREF = “#Глава 1”>Глава 1</A> текущего документа.

Для более сложных документов HTML имеет некоторые дополнительные возможности форматирования. Так, HTML поддерживает ненумерованные и нумерованные списки. Ненумерованный список:

<UL><LI>список пунктов </UL>
Например:

<UL>

<LI> яблоки

<LI> бананы

</UL>

что дает на экране:

( яблоки

( бананы
Нумерованный список идентичен ненумерованному списку, только вместо <UL> используется <OL>.

Например:

<OL>

<LI> апельсины

<LI> персики

<LI> виноград

</OL>

что дает на экране:

1. апельсин  2. персики  3. виноград
Программа просмотра автоматически нумерует элементы такого списка.

Списки могут быть произвольно вложены, хотя практически было бы разум- нее ограничиться тремя уровнями вложенных списков.

Приведу пример вложенных списков:

<UL>

<LI> Крупные города России

<UL>

<LI> Москва

<LI> Санкт – Петербург

</UL>

<LI> Крупные города Украины:

<UL>

<LI> Киев

</UL>

</UL>
что дает на экране:

( Крупные города России:

( Москва  ( Санкт – Петербург

( Крупные города Украины:

( Киев

Флаг <ADDRESS> используется для того, чтобы определить автора докумен-

та и способы контакта с ним (например, e-mail адрес). Обычно это последний пункт в файле. Например, последняя строка документа может выглядеть так:

<ADDRESS> Web – master Воронежского педуниверситета 

den@vspu.ac.ru</ADDRESS>
что дает на экране: Web – master Воронежского педуниверситета den@vspu.ac.ru
Можно описывать специальными стилями отдельные слова или предложе – ния. Имеются два типа стилей: логический и физический. Логические стили определяют текст согласно заданному значению, в то время как физические стили определяют некоторые участки текста.

Логические стили:

<DFN>         служит для описания определений. (Это определение.)

<EM>           служит для выделения слов. (Это выделенное слово.)

<CITE>        служит для выделения заголовков книг, фильмов, ци – 

                     тат и т.п. (Это цитата)

<CODE>      служит для выделения программных кодов, текстов 

                     программ и т.п. Изображается шрифтом фиксирован – 

                     ной ширины. (The <stdio.h>header file)

<KBD>        используется для ввода с клавиатуры пользователя. Мо-

                     жет быть изображено жирным шрифтом (но в большинст-

                     ве browser изображается специальным шрифтом).(Введи-

                     те passwd)

<SAMP>      используется для машинных сообщений. Изображается 

                     шрифтом фиксированной ширины. (Segmentation fault:Co- 

                     re dumped)

<STRONG> служит для ОСОБОГО выделения слов. Обычно выделяет-

                     ся жирным шрифтом. (Это очень важно)

<VAR>        используется для символьных переменных. (Это переменная)

Существует физические способы выделения – автор задает стиль написания текста, описывая шрифт в исходном HTML – документе. Можно задать:

<B> , </B>       жирный шрифт (это жирный шрифт)

<I> , </I>          наклонный шрифт (это наклонный шрифт)

<TT> , </TT>   фиксированный шрифт (шрифт заданной ширины) (это fixed шрифт)

Используя флаг <HR> можно разделить текст горизонтальной чертой:

Этот текст снизу от линии.

Большинство программ просмотра могут показывать рисунок X Bitmap (XBM) или GIF формата вместе с текстом. Чтобы включить рисунок, на-

до описать гиперссылку на него:

<IMG SRC = image_URL>

где image_URL – URL .gif или .xbm файла, содержащего рисунок. Таким

образом синтаксис ссылки на рисунок аналогичен синтаксису гиперссылки

HREF. Форматирование положения рисунка задается включением в гиперс-

cылку пункта “ALIGN=”

<IMG ALIGN = top SRC = image_URL>

Также возможны типы выравнивания:

ALIGN = MIDDL
ALIGN = CENTER
Поскольку пересылка картинки замедляет загрузку основного WWW – доку-

мента, рекомендуется помещать рисунок в отдельный документ, написав на

него гиперссылку. В этом случае пользователь сам может решить – смотреть

или не смотреть ему этот рисунок:

<A HREF = image_URL>Здесь</A> вы можете увидеть рисунок.
Рассмотрим более длинный пример HTML – документа:

<HEAD>

<TITLE>;Более длинный пример</TITLE>

</HEAD>

<BODY>

<H1>Более длинный пример</H1> Это простой HTML – документ.

Это первый абзац. <P>

Это второй абзац, он демонстрирует некоторые возможности HTML по выде- лению слов.

Это слово написано <I>наклонным</I> шрифтом.

Это слово написано <B>жирным</B> шрифтом.

Здесь вы можете увидеть картинку:

<IMG SRC = “LOGO.GIF”>P>

Это третий абзац, он демонстрирует использование гиперссылок.

Это гиперссылка на файл minihtml.html, содержащий простой пример HTML- документа:

<A HREF = “minihtml.html”>Пример HTML – текста</A>.<P>

<H2>Заголовок второго уровня</H2>

Дальнейший текст будет написан шрифтом фиксированной ширины: <P> <PRE> On the stiff twig up there Hunches a wet black rook Arranging and rearranging its feathers in the rain …

</PRE> Это ненумерованный список, состоящий из двух элементов:

<P>

<UL>

<LI> смородина

<LI> черника

</UL>

Конец документа. <P>

<ADDRESS> Web – master Воронежского педуниверситета den@vspu.ac.ru</ADDRESS>
                            Тэги HTML и их атрибуты

	    Назначение
	          Тэг
	     Атрибуты
	      Значения                          атрибутов       

	                                 Структура HTML –документа 

	Содержимое HTML –документа 
	<HTML> …

</HTML>
	             - 
	             -

	Заголовок 

HTML – документа 
	<HEAD> …

</HEAD>
	             -
	             -   

	Тело HTML - документа
	<BODY> …  

<\BODY>
	
	

	-цвет фона
	
	BGCOLOR
	название цвета  или его 16- рич – ный код 

	-цвет текста 
	
	TEXT
	название цвета или его 16- рич-ный код

	-цвет еще не посещенных ссылок   
	
	LINK 
	название цвета или его 16 - рич-ный код 

	-цвет уже посе-щенных ссылок 
	
	VLINK
	название цвета

или его 16 - рич-ный код

	-фоновая гра- фика
	
	BACKGROUND
	имя файла фоно- вой графики (GIF JPEG), его адрес URL и путь к не- му  

	-фиксация фо- новой графики
	
	BGPROPERTIES
	FIXED

	-поля слева
	
	LEFTMARGIN
	ширина полей в пикселях или нуль для «отклю- чения» полей

	-поля сверху
	
	TOPMARGIN
	

	Титульная строка
	<TITLE> …

</TITLE>
	             - 


	             -           

	                                      Оформление текста

	Абзац
	<P>…</P>
	
	

	-выравнивание
	
	ALIGN
	LEFT, CENTER, RIGHT, JUSTIFY 

	Разрыв строки межабзацным отступом
	<P>
	                  -
	                  -    

	Разрыв строки без отступа
	<BR>
	              -
	              -

	-прерывание оборки текстом
	
	CLEAR
	LEFT, RIGHT, ALL

	Заголовок и подзаголовок
	<H (1-6)> …

</H (1-6)>
	
	

	-выравнивание
	                   
	ALIGN
	LEFT, CENTER, RIGHT

	Вид шрифта
	<FONT> …

</FONT>
	
	

	-цвет текста
	
	COLOR
	Название цвета или его 16-рич- ный код

	-размер симво- лов


	
	SIZE
	Абсолютное (от 1 до 7) или отно- сительное (+/-) числовое значе- ние в условных единицах

	

	       Размещение иллюстраций и прочих графических                элементов

	Вставка иллюстрации
	<IMG>
	
	

	-местонахожде- ние файла ил- люстрации
	
	SRC
	имя графичес-   кого файла (GIF, JPEG), его адрес UPL и путь к не- му

	-ширина
	
	WIDTH
	числовое значе- ние в пикселях или в процентах

	-высота
	
	HEIDTH
	Числовое значе- ние в пикселях

	-оборка текс- том
	
	ALIGN
	LEFT, RIGHT, TOP, BOTTOM, MIDDLE, CEN- TER

	                                                    Списки

	Маркированный список
	<UL>…</UL>
	
	

	-символ марке- ра («буллета»)
	
	TYPE
	DISC, CIRCLE, SQUARE

	Нумерованный список
	<OL>…</OL>
	
	

	-тип нумерации
	
	TYPE
	1, A, a, I, i

	                                             Гиперссылки

	Гиперссылка
	<A>…</A>
	
	

	-целевой ад-

рес/файл 


	
	HREF
	имя файла, ад- рес URL, путь (в разных ком- бинациях); ma- ilto: [адрес] -   для отправки эл. почты;   # [имя]-для пере- хода к заклад-ке 

	-закладка
	
	NAME
	имя закладки

	-текст поясне- ния
	
	TITLE

	Строка текста в кавычках

	
	
	
	

	
	
	
	

	
	
	
	


Программа Flash
На сегодняшний день Flash Player используют 222 миллиона человек, и каждый день его скачивает еще 1.4 миллиона. По данным Macromedia это позволяет 90% пользователей Сети просматривать страницы с Flash содержимым. 

Программа Flash 5 работает под Windows 95/98/NT/2000. Установить ее очень легко - с этим справится любой, кто установил хотя бы парочку программ в Windows. После установки можете смело заходить в нее, и вот, приблизительно, то, что вы увидите: 

[image: image1.png]



Интерфейс Flash 5 очень похож на интерфейс программ Adobe. Он весьма удобен и легок. После некоторого времени работы с программой понимаешь, как хорошо все продуманно и сколько труда разработчики Macromedia вложили в свое детище. 

Слева находятся панели инструментов. С помощью них можно выбирать инструменты, а также управлять рабочей областью, модифицировать объекты и выбирать простые цвета. Справа находятся диалоги настройки инструментов, цвета, текста, свойства кадров и объектов. Посередине - рабочая область, где мы будем творить, а над ней шкала времени (Timeline). 

Во Flash очень интересно рисовать. Этот векторный редактор не похож ни на один из существующих. К сожалению, подробное описание инструментов рисования выходит за рамки данной статьи. Впоследствии, мы можем рассмотреть эти инструменты подробнее. Самый хороший способ чему-то научится - практика при каком-то количестве теории. В качестве практики просто поэкспериментируйте с различными инструментами, а в качестве теории можете прочитать про это в книгах или в Сети. 

Странички (файлы, анимации - как хотите) Flash принято называть фильмами (Movie), хотя мне больше нравится слово "мультик". Наверное, это оттого, что во Flash имеется шкала времени и, хоть вы и обладаете безграничными возможностями по использованию этой шкалы, ваше творение все равно будет упорядоченно выполнятся во времени. На самом деле, вы можете останавливать, вновь запускать мультик, прыгать с одного кадра на другой, загружать другие мультики и много еще чего. 

Процесс создания состоит в следующем. Вы создаете так называемый "авторский файл", который имеет расширение .fla, а затем он транслируется в результирующий .swf файл, который уже может быть просмотрен в браузере, обрамлен с помощью HTML, и т.д. Кстати, Flash может записать ваше творение в отдельный исполняемый .exe файл, сгенерировать java-код. И даже сохранить в виде статического GIF изображения. 

Давайте попробуем нарисовать первый простой мультик. Нам понадобятся инструменты - "овал" [image: image2.png]


и "выделение" [image: image3.png]


. Выполните следующую последовательность действий: 

1. Выберите инструмент "овал" и нарисуйте с помощью него овал или круг в левой части сцены. 

2. Далее выберите инструмент "выделение" и выделите весь овал вместе с кромкой. Для этого либо охватите вашу фигуру прямоугольной рамкой, держа кнопку мыши нажатой, либо два раза быстро щелкните на ней. У вас выделится весь овал. 

3. Теперь войдите в меню Insert и выберите Convert to symbol (или нажмите F8). В появившемся диалоге выберите селектор Graphic и нажмите ОК: 
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4. Теперь выберите на шкале времени вверху 25-й кадр (просто щелкните по нему мышкой), и выберите меню Insert -> Keyframe (или нажмите F6). Этим вы создадите так называемый "ключевой кадр" на 25-м кадре вашей шкалы времени. У вас должно получиться нечто похожее: 
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5. Выделите теперь ваш кружок (теперь вокруг него возникнет голубая рамка) и переместите его в правую часть рабочей области. 

6. Вернитесь на шкале времени в 1-й кадр. (В доказательство Вы должны увидеть свою фигуру опять в левой части экрана). Из меню Insert (или из контекстного меню при нажатии правой клавиши мыши на первом кадре) выберите Create motion tween. 

Поздравляю! Вы только что сделали очень простой, но уже мультик, во Flash. Выберите Control > Play (или просто нажмите Enter) чтобы просмотреть результат. 

7. Давайте добавим кое-что в наш мультик. Выберите опять 25-й кадр и выделите вашу фигуру. Войдите в диалог Effect. Если сложно отыскать нужную закладку в диалогах справа, выберите Window > Panels > Effect. В выпадающем списке в этом диалоге выберите Alpha (прозрачность), а появившийся параметр опустите до 0%. 
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Попробуйте еще раз проиграть ваш фильм. Во Flash можно всего лишь задавать "ключевые точки" анимации, программа сама будет просчитывать промежуточные кадры. Хотя вполне возможна покадровая анимация. 

8. Последний шаг. Нам нужно оттранслировать наше творчество в .swf файл и сгенерировать HTML файл, который загружал бы мультик в браузер. Это можно сделать, выбрав File > Publish (или нажав Shift-F12). 

Теперь можно открыть созданный вами HTML файл в браузере. Это можно сделать даже из Flash, выбрав File > Publish Preview > HTML (или нажав F12). При этом Flash воспользуется браузером, установленным по умолчанию. 

